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* Overview

# Creating Network From Scratch

» TransCAD Model Conversion

» Network Editing

# Network Parameters

» Eureka Model Developed by Caliper
# Signal coding

# Count coding

# Zone Connector/Aggregation
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Create Network From Scratch

Choose a Type of File

2na Sureet
w S [

Chart

Dataview
Layout

&8 Save Simulation Database As

A | « Documents > Caliper > TransModeler 5.0 v O Search TransModeler 5.0 P

Organize v New folder

A Name Date modified Type Size
# Quick access
ic Fi 3D 5/2/201812:03PM  File fold
. Geographic File Wockop  # ' ile folder
| Extensions 4/26/20181:27PM  File folder
Table oA Plugins 5/2/20181203PM  File folder
Documents. # Tab 5/2/20181203PM  File folder
& Pictures | Tutorial 5/2/20181204PM  File folder

Matrix

Rira * U3DModels 5/2/201812:04PM  File folder
y‘ Route System & NasuniData 0 # | Units 5/2/201812:04PM  File folder
= i Apisi WebMapServices 5/2/20181204PM  File folder

| DVD1

| Eureka

| Create a new simulation project

| KosterSubareaOl

Create-a-Map Wizard ?

Egnyte
[ This PC

Create a New Map
- CODEMETER(D:) v <

Map of my own data

(® General purpose map \ \ Sa:::;r:}l e
il Browse’i \\‘Z\\,\P : \“\ ‘ A Hide Folders
Area to Display in the Map \” "\ \ \\ i 'M ;;_ "
\b\ \\ \ =
e
City “ Eureka | \le \%\
State/PR “ ca |
Map Layer |0penStreetMap v |

Region ’World (HERE, Caliper) - 2017

 Next>
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Network Editing - Editing Toolbox

% Project 2 Road Editor > Toolbox

Road Property

Add/ Remove
Segments

Join/ Split i
Segments

Add/ Remove
Lanes

Add/ Remove
Lane Connector

Shared
Centerlane

Median

Create
Roundabout

Reverse
Direction

Add Acc/Dec
Lane

i et ux & &

Layer Attribute

Accept/Reject

V s-;@/é %
/

Add/Remove
Zone Connector

Changes

I0eD
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Editing Toolbox-Settings

Road Editor n

B:lbo- A ALL FEER-|

Y- M TN AT

DEE@C %A &

Road Class IUndefined v | |
Lanes on Left ,1_E | on Right ,1_E |
Lane Width (ft) [ 12 || (JOne Way |

Road Editor Configuration ? X

New Features Parameters Options Key

Links
Road Class |Major Arterial v |_|

Elevation (Feet)

New Links Intersect
Click Curves

Segments
Fidelity [ Micro V]
One Way Lanes on Left (B&) || 1 ﬂ
Lanes on Right (AB) |1 E
Lanes

Lane Width (feet)

Turn Bays
Create Island Island Length (feet)

[Jpual

[] shift Centerline

[ ok ] cance

Road Editor Configuration ? X

New Features Parameters Options Key

Road Editing Buffer Symbol Key

Symbol and Keyboard Shortcut Descriptions:

n Shape Point (N
@ Shape Point at End of Segment
D Shape Point at End of Link

1. Click and drag the pavement (rather
than shape points) on a segment or
inside an intersection to move shape
points together.

2. Pressthe 'T' key when clicking a
segment with tapered lane widths to
set the desired position of the
end of taper.

[ ok | cance |
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Editing Toolbox-Properties-Line Layers

Road Editor nl
(o) 4 4 4 4 R |

Y- MU A4S
MMNE®E % A- € E 8-

Road Class |Undefined V]|

Lanes on Left [ on Right [1—5 |

Lane Width (ft) [12 || [JOne Way |

fi Edit Road Properties

Link  Segment Lane

General

Link Attributes

x

Link ID | 5253 Direction | SWB (AB)
From Node | 842890 To Node | 842043

Road Class |G e | | Edit Class.. |

Edit Road Properties ? X

Link  Segment Lane
General

Segment number 1 out of 1 link segments.
(Counting in the direction of traffic)

Segment ID | 5253 Direction | SWB (AB)

Segment Attributes
Number of Lanes | 2 E Reversible
[] Median Divided [[] Shared Center Lane
[ Tunnel
Segment Fidelity On Street Parking
(® Microscopic [ Left Side
O Mesoscopic [JRight Side
(O Macroscopic
Tapering

Expand the road gradually when 2+ lanes merge or diverge

@ Default (O Other

Length (feet):

ITH Cancel ‘

Edit Road Properties ?

X

Link  Segment Lane
General

Lane number 1 out of 2 segment lanes.
(Counting from left to right)

Lane D |43 Direction | SWB (AB)

W

Lane Attributes

Width (feet) | 12.00 Shoulder [JPassing
Lane Changing

To Left | Prohibited v To Right |Allowed v
Lane Use

’ Copy Lane Properties

g

K l Cancel ‘

d
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Editing Toolbox-Properties
Node & Lane Connector Layers

Edit Lane Connector Properties

Edit Node Properties
Node

General

Node ID | 842043

Priority |Priority Road

Node Fidelity
(® Microscopic
(O Mesoscopic
(O Macroscopic

Lane Connector

General

Lane Connector ID | 902
Turning Movement Type | Through

Lane Connector Attributes

Connectivity Bias (0-1) | 1.00

[J Waiting Zone

Options
[[]Reset Yield Position
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Network Editing — Line Layers

# Not only different line layers carry specific network parameters, but each

produce certain output.
* Segment:

Flow, Density, and Speed

will be updated continuously
during the simulation, and
output report can be generated
based on user-defined time
aggregation.

Fidelity, grade and parking
information are input to this layer

Dataview1 - Segments Info = O X
ID 5253

Link| 5253

Position| 1

Length 0.09

Lanes_AB 2

Lanes_BA, 2

[Reversible Lanes), 0

[Center Lane) No

Divided No

Fidelity Micro

[Free Flow Speed] 35.0

[Speed Limit), 25.0

Cursatiel nn

Grade_AB 0.0

Grade_BA 0.0

Tunnel No -

Parking_&B None -

Parking_BA| None
Flow_&B
Flow_Ba,|
Density_AB
Density_BA,
Speed AB
Speed B4
[K/Kjam_AB)|

[K/Kjam_BA)| -

[Dir:1] 0

[Length:1]| 0.10

ValNotes o7

CTOCCThIARC

L LI\.NH
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Network Editing — Line Layers

2 Link;
Queue and toll information will be

dynamically updated during
simulation. Road class, car following,
priority, are examples of parameters

that are only editable through link layer.

| - Links Info - O X

ID 5253

Dir 0

AB Sw

Ba) NE

ANode 842830

BNode 842043

Superlink 5253

Lenath 0.09

Seagments| 1

Type Street

Priority 9

Domain -
Access_AB
Access_BA,
Control_4B
Control_Ba,)

Facility -

Name US HwY 101

Class| Undefined .

Disabled_AB No -

Disabled_Ba, No -

[Car Following] =
Tol_4B
Tol_B&,

Queue_AB 0

Queue_BA, 0
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Network Editing — Line Layers

» Lane;:

10

Density and speed per lane are dynamically
updated during simulation and can be
collected by user-defined aggregation

level after simulation.

Lane restriction/ discount for certain user
such as trucks, HOV are defined in this layer

Lane change restriction is defined
in this layer.

Lanes Info - O X
ID 65|
Segment 5253
Link 5253
Dir -1
Position| 2
Left 684
Right -
Turns| T
Group
Reversible
Side| Right
Auziliary|
Merged No
Merging|
Pivat
Exit No
Dropped No
Parking| No
Stopbar] 0.00
Width 12.00
Passing| No -
Shoulder No +
Barrier None .
Change| Left
ETC] -
HOY| -
Transit -
Truck| -
[User A) -
[User B) =
HOT -
Automation ~
Bicycle -
Density -
Speed
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Create Network From Line Layer

¥ Import Subarea Model
1. File = Open (.dbd)
2. Make a selection set of TAZs in the TranCAD .dbd (activate the node layer)*

3. Optional: Create a custom lookup table for road classification: Parameters—>
Road Classification - Default Road Classes & Lookup Tables
Right click on Lookup Tables and select Add. You can later edit this list.

g Default Road Classes & Lookup Tables X

- Default Road Classes
¢ - Modified Greenshields
! i.Piecewise Linear Road Class Lookup Table = 4 $F X 1L ™M
. eVanberde —
& Lookup Tables Code | Class ‘ Description ]
Tiger Al Freeway Primary highways, unseparated
EE;T_:&' 412 Freeway Primary highways, unseparated, in tunnel
S Freeway Primary highways, unseparated, underpassing
Add a New Road Classification X |, . . e
Freeway Primary highways, unseparated, with rail line in center
Enter a Name Freeway Primary highways, separated
” Eureka | Freeway Primary highways, separated, in tunnel
Freeway Primary highways, separated, underpassing
Freeway Primary highways, separated, with rail line in center
I OK I \ Cancel =
| Major Arterial Primary roads, unseparated
* .
Refer to slides 8-10 - -
11 CAMBRIDGE SYSTEMATICS




Create Network From Line Layer

# Import Subarea Model

4. File > New Simulation Project
5. The program will ask you to save the .dbd, save it in a new folder in which you
want to have your simulation database. This way, the original .dbd file in the old

folder will remain accessible/editable by TransCAD.
*Note: If you have not created a road classification lookup table in step 3, select

“None” for Functional Type Classification

M New Simulation Project @ Import Network

SrcatealNewlEioreck Functional Type Classification

? X
() With a New Simulation Database Table |Eureka o |

Choose a Type of File

(©) Using an Existing Simulation Database
Link Info
@ By Converting a Line Layer
= Link ID |ID v
Line Layer Network v I l Import Options ? X
Dataview Line Set Entire line layer - Street Name |STREETNAME "l -
ptions
Joute Svstern - Lanes [[AB_LN / BA_LN] v
Layout Route System | | I | Default Fdelity
. Geographic File Route Set | ~| Class |FT vl
[[JRemove Unnecessary Nodes
e Number of links selected: | 646
Table Traffic Drives on the Import Attributes
E O Left © Right Node Info
SZ
Route System i Options Centroid Set |IntemaIZones vl I OK I | Cancel |

Use Current Map [ Create a Map... J Fidelity INone vl
Create a new simulation project
[ o ] [ P ] Number of centroids included: | 59
- CAMBRIDGE SYSTEMATICS
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Centroids vs Boundary Nodes

# TransCAD subarea contains internal and external zones. Internal zones are
the ones that were TAZs in the initial, regional model; external zones are the
ones created by cutting the subarea from the regional model.

» When you make a selection set in the node layer for TAZs, Transmodeler
creates centroid and centroid connectors for them.

» If your selection set only includes internal zones, Transmodeler creates
centroids only for internal zones, but still recognizes the external zones as
nodes with type “Boundary” when creates a simulation data base.

» Trips can be generated from and destined to both Centroids and Boundary
nodes

13 CAMBRIDGE SYSTEMATICS i




Eureka Subarea-Internal Zones

Contains 59 zones.

Select by Condition (Dataview: Nodes)
Enter a Condition
ZONE>0
Condition Builder Set Name
=
%
[ Select from visible features on U—Cond’to . )
/ //7_J
'y
H —
w SRR RRTREss
VA i T =
./-/’Q /‘\q—J/‘\ T | T } __lﬂ gt:
/j/ ]l J]ll J‘f g.
o/ 1 J l T l J [T =
L
H;W TR
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Eureka Subarea-External Zones

(LB _
RESETS sucHe Contains 203 zones (blue dots)
T SIS
< de -34;;;;«.. ;,u,»{ e
0

regional model, but were

e et | T L . _ -
B ER L g s W They didn't exist in the original,
. of Tl
Select by Condition (Dataview: Nodes) ? X .t: .'_;1 Y ¢ " ==\

e el created as the subarea was cut

‘ e e TS from the regional model
Condition Builder Set Name 14 "‘l’l/. ":#”if =
E ——— et
_ oo s |9 @ K== an . L .
[Trﬂ%ﬁﬁrm TI1L, Associated Matrix with this
AR subarea is a square 262*262
=D matrix
e aerree s,iiin (2622203+50)
o AV —HH ¥y FH
LA 4 ; ;*’g T * s8¢ ?« ® ] ’.\_.
i { / TII T llll i] ” I °
- lll ¢ lll $.l$ .—‘o
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Only Internal Zones converted to Centroids

Only Internal Zones (59 zones) are created as
centroids. However, noes such as 842288 are
created with Type=Boundary

Shown in pink selection set

These nodes can generate and attract trips.

Select by Condition (Dataview: Nodes:1) ? X
Enter a Condition
Type= "Boundary"|
Cancel
Verify
Condition Builder Set Name
Clear
Field List... v| | MyExternal v
1 Calartinn Mathnd Save

CAMBRIDGE SYSTEMATICS i
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All zones were converted to Centroids

If we select all internal and external zones to be converted to centroids during
simulation database creation:

 tect by Conditon (Dataview: Nodes) Pox All 262 zones (internal and external) will be
A Enter a Condition . . .
|[suBareasero | converted to centroids, matching the size of
Cancel .
_ the trip tables.
Verify |
1 Condition Builder Set Name Clear
Field List... vl | AllZones v i
Save...

Centroid connectors are not
supposed to connect to
intersections, only to the i
middle of links. Therefore, ”

centroid connectors shown in
red circles should be moved.

17 CAMBRIDGE SYSTEMATICS i




Centroid Connectors

» Don’t connect centroids to intersection/nodes

# Don’t connect centroids to the major roads

# Should more or less represent the traffic loading in the real world
* May be adjusted during the calibration and based on traffic counts.

» Zones shouldn’t be connected to each other with zone connectors.

CAMBRIDGE SYSTEMATICS i
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Network Checking, Cleaning

# Project > Road Editor > Check Network

» For each problematic item, a selection set is created in the associated layer

Check Network

Check network for

= | msmm  Check: Poor Geometry (4) VH 4 W D T

Errors in intersection geometry
Short segments (< 100  feet)

Errors in segment geometry (shape, grade, and elevation gaps exceeding |1.0 feet)
Missing lane connections

["] Check parking lanes

Check shared center lanes

Check reversible lanes

[] Check disconnected turning movements (between links with priority < [7— )
Potential merging conflicts
[¥]Invalid superlinks

["] Reset if invalid
Signalized intersections without timing plans
Detectors not assigned to any phase
Node and segment fidelity errors

Check All [UncheckAII ][ Remove Sets OK H Cancel

19
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Network Editing - Imagery

» Maps - Imagery - Google Map
» Slow downs panning i

Mr Fish Seafood ¢

Six Rivers National
Forest Headquarters Chevron Eureka

Op,
Ca..
@dllzj

Discovery Inn @

-, Bayview

%S,
67(@ [/{43) -
Applebee’
s Cosm
(&)
) ()
Subway
® @
SJ.l.L A m ‘
i i V!
@ f Happy Donuts @C S
S (o) ‘
@
i AutoZone \
Taco Bell / ) eTri Col

| homas St

1S uobaip
1S EpEASIY-
IAY [B1US]

1S UbiH
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Exercise - Network Editing

# Select/ move / extend / add / remove shape points
# Add / remove segment (intersect / direction / lane # / road class / fidelity)
# Split / join segment / links

» Add / remove lane / lane barrier

# Add acceleration / deceleration lanes

» Add / remove lane connectors

» Add / remove zone connectors

# Add / remove median

# Add shared center lane / Turn Bay

# Add roundabout

# Smooth curves

» Reverse direction

CAMBRIDGE SYSTEMATICS i
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Network Editing - Fidelity

# Nodes and Segments have a property called “Fidelity”
# Determines how travel time is calculated
» Macroscopic’ Mesoscopic, Microscopic

» Each fidelity level requires certain set of parameters that can be edited through
Parameters—> Edit Road Classes, Parameters - Driver Behavior, and
Parameters - Mesoscopic/Macroscopic

# Network can include all fidelity levels (Hybrid)

» Default fidelity is decided at the time of network conversion, but can be edited

* When model fidelity is set as Macro or Meso, network details will be hidden (by default)

CAMBRIDGE SYSTEMATICS i
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Fidelity - Microscopic

. . ] Driver Behavior )
# 3 main categories: Network -
related, general, and driver CarFoIInwingModelParam::e;s - _ I
a eta amma Theta
behaVior Accelerating 2.81 167 -0.89 1.00
Decelerating 4.65 1.08 1.65 1.00
# Microscopic simulation models |~ “eisuean
u . . . y eighboring Lane Mode
individual vehicles’ car L yaTergetLave odel
. . Look Ahead
following and lane changing. 5 Cicn D
Segment’s speed is average of | romtverides =
speeds of all vehicles that L eeromtees
. - Linear‘ModeI
passgd that segment during lerirea o
that time interval. g=
- Desire to Pass
O . = Mer ir;-,Croel,s‘in , and Yieldin |
# Driver behavior parameters " FeadvayTheshos
can be changed through & Roundaberts L
o o . - General
Parameters >Driving Behavior. ||, -cisiinimepeiss -

7 7 Filter v X Default Apply [ Cancel H Help ]

CAMBRIDGE SYSTEMATICS i
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Microscopic Parameters- Road Class

M

Name Freeway v I Add H Remove H Zoom ]

General | Microscopic |Mmscop|c IMacmscoplc'
Parameters

Speed Limi (mph)  65.0

Desired Speed Distribution b

Standard

Apply J [ OK ] [ Cancel
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Fidelity - Mesoscopic

# In mesoscopic simulation, vehicles are organized into platoons called traffic
cells and streams. While the model tracks individual vehicles, the

simulation of vehicle movements is based on aggregate speed-density
relationships.

¥ Parameters > Mesoscopic/ Macroscopic

-ﬂ Mesoscopic/Macroscopic 5

=2- General Parameters Mesoscopic Parameters - Traffic Cells and Strean

. ‘- Step Size and Lane Distribution

- Mesoscopic Parameters Traffic Cell Management
Jam Density and Speed Scenatrio Distance (ff) |
Merging two cells 100.0
Splitting a cell 200.0
Free flow 300.0
Owvertaking 100.0

Traffic Cell Headways

Ideal headway (sec) 1.20
Typical passenger car length (ft) 18.0
Minimum length for using speed density function (f) 100.0

7 7 Filter v % Default Apply [ Cancel H Help ] “
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Mesoscopic Parameters — Road Class

M

Name Freeway v Add [ Remove ] Zoom

| General | Microscopic | Mesoscopic | Macroscopic |

Parameters Speed-Density Curve
Curve Type [Non-Lnea' '] 20
Free Flow Speed (mph)  70.0 <
Apha 18000
Beta 5.0000
=
Q
E
o
(3]
2
m -
0 L et
Number of Lanes 1 0 Density (veh/mi) 200

[ Apply ] [ OK Cancel ]

CAMBRIDGE SYSTEMATICS i

26




Fidelity - Macroscopic

# Macroscopic simulation uses BPR function to estimate segment’s travel time
based on volume.

» Within all fidelity levels, TransModeler tracks individual vehicles, and a
trajectory file can be generated regardless of fidelity level.

# Despite macroscopic models used in static traffic assignment tools, even
with a link fidelity of macro, maximum number of vehicles passing a link is
restrained by link capacity and storage, and queue starts forming once these

values are reached.

CAMBRIDGE SYSTEMATICS i
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Macroscopic Parameters- Road Classes

MI

Name _Freeway v [ Add H Remowve H Zoom ]

| General | Microscopic | Mesoscopic | Macroscopic |

Parameters

Capacity fpc/h/)  PZINE

Volume-Delay Function
Apha  0.5000
Beta  9.0000

Apply ] [ OK ] [ Cancel ]
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Network Editing - Road Classes

# Each road class share the same network attributes such as free flow speed,
VDF function parameters, capacity, saturation flow rate, etc.

» Default classes can be edited and new classes can be defined through
Parameters—> Edit Road Classes.

# Capacity and free flow speed can be assigned through road class or based
on segment attribute, but other network parameters can be assigned to a link
only through road class definition. If any of these parameters need to be set
differently for a single link, a new road class should be defined and assigned
to that link.

CAMBRIDGE SYSTEMATICS i
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Joining Links and Segments

» Sometimes you start with FFS and capacity based on road user class
(probably adopted from initial TransCAD network), but you want to switch to
segment-level FFS and capacity, and change these values for limited
segments. To keep these values for the segments that you don’t want to
change, you can create association between Links and Segments through
Dataview—> Table-> Join -

Join Dataviews ? X

Choose the type of join you want to create
(® Join link and segment fields

(O Join road class fields to layer

O Join turning movement tables

O Join any table to a map layer

(O Join any two kinds of tables together

| OK | ’ Cancel

CAMBRIDGE SYSTEMATICS i
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Eureka Subarea Road Class

In the .dbd layer: . |Network )=

Color Theme (Layer: Network) ? X Color Theme (Layer: Network) ? X
Settings Styles Settings Styles r
General

Choose a class

Field [FT V] P ;3;:1:;)(0) v \

Method |List of Values v| | Load.. | 4(a1)
J_ Max Classes Recalculate EE:; :
I~ Z . i (30) Style (9 (74))
Options
more values below or above ’ Line Settings
- Legend Text Style I[ ] Vl
|94 Width [1 v
s Break at
o . Color Sets C°|0f
| | I I I I I ' \ \ Treat zeros as missing values -
l l | | | | | l I l /| Round off the values in each class IM] \M SwapSta Opacity || 100 E
) / = I [ Include counts in legend From to Y31 Arrowheads
@ None O Direction of Flow O Topology
Other Settings
| OK I l Cancel l ‘ Apply l l Remove ‘ |(" i | [ oK ‘ l Cancel | | Apply ‘ [ Remg
Facility types of 3,4,5,6,7, and 9
o [ ok ]| cancel || Apply Reset
| T

T

31
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Eureka Subarea Road Class

» Through
Parameters—> Road Classification—> Default Road Classes and Lookup
Tables, and Parameters—> Road Classification—> Edit Road Classes you can
modify the user road class. We start with a user class that corresponds with
the regional model. Will revise it based on the local knowledge/ previous work

32

by Caliper.

ﬂ Default Road Classes & Lookup Tables

[=- Default Road Classes

. - Modified Greenshields
. Piecewise Linear

L eVanberde

Road Class Lookup Table

X

+ 44X LM

Code l Class I Description

|

3 Maijor Arterial

Minor Arterial

Local Street :I

Local Street

~ @ o e

Minor Collector

Centroid Connector Codes

+ 4% X LM

Code Description

9 Centroid Connector
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Eureka Subarea Road Class

. . Dataview - Links Info - O X
You can assign user-defined road class . et .
. Dir 0
to links, but not through the = s
B4, NE
Eureka Lookup Table Ailode B2
BNode] 842709
Superlink| 7642
Length| 0.05
Segments| 1
Type] Street
Priority 9
Domain
Access_AB
- Access_BA|
[ Edit Road Classes X Control AB
Name IHira_MinorArterial VI l Add Remave Zaoom COI’I[IOL?A
L . Facility -
General Microscopic Mesoscopic  Macroscopic Name US Hw'y 101
Parameters Class Undefined v
Disabled_AB| Undefined
Prorty BRI Acces: Road
—_— 5 | iy
Special Type  None v [Car Following] Frepeway
—_— Tol_AB| Freeway [Piscewise Linear)
Saturation Flow (PCE/hr/lane) o Fieaway VanAcrde)
= 1Local Street
Travel Time Perception Emor (%) Queue_AB| Major Arterial ©
7 M@ior Colle_ctor "
Number of Segments Using this Class :‘ m::g: égﬁgg or '1
Microscopic 0 i g:'rln 1
e[ 0 \ i
S g E Roundabout i
Macroscopic 0 i ?:slfelr': Ez:i-:y 1
: Trail or Other Local Road I
I Tunnel |
J Waterway i
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